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Objective

The objective of CONQUER™ FOR WINDOWS is to destroy all of your opponent's pieces and force a 
surrender while capturing as much land as possible. In some scenarios, there may be a limit to the 
number of turns in a game. In those games, the objective is to score as many "points" as possible by 
taking your opponent's land and cities while destroying your opponent's forces. Naturally, your opponents 
will be attempting to do the same to you at the same time.

All moves are simultaneous. That is, while you are moving so is your opponent. It is possible that your 
attacks may be preempted by attacks from enemy forces. It is also possible that while preparing an 
attack, you find the enemy has either retreated or reinforced his pieces - thus radically altering a battle's 
outcome.

During the game, you will need to build enough cities to produce armies that can be used to defend your 
home territory and to attack enemy positions. Production must be constantly monitored, or you will run out
of food and mineral resources necessary to build reinforcements. In the end, it is the player that best 
manages production who usually emerges the victor.



Keyboard and Mouse Commands

Many of the commands available throughout the game are combinations of key strokes and mouse 
actions. A plus sign, "+", between key names or mouse actions means to press and hold the first key while
you press the second key or perform the second action. For example, CTRL+X means to hold down the 
CTRL key, press the X key, and then release both keys.

For mouse actions, LEFT and RIGHT refer to the buttons on a two button mouse. CLICK means to press the 
mouse button and then release, HOLD means to click and hold down the mouse button, and DRAG means 
to move the mouse while a button is held. For example, LEFT-HOLD+DRAG means to click and hold down 
the left mouse button while moving the mouse over an area.

Menu Items

Key Menu Item Description
F1 Help Display online help
F2 Planning Show statistics on pieces being built
F3 Resources Show statistics on food, gold production
F4 Battle Show statistics on combat resolutions
F5 Current Scores Show players' scores
DEL Disband Troops Disband selected pieces in cache
CTRL+C Communication Area Show or hide message area
CTRL+F Follow Path Signal pieces to follow the path
CTRL+O Sound Enable or disable sound effects
CTRL+P Pause Game Pause single player game
CTRL+S Save Game Save game to disk at the end of the turn
CTRL+T Tool Bar Show or hide the tool bar and buttons
CTRL+W World Map Show global or windowed view
CTRL+X Show Production Show production or tactical view
CTRL+Z End Turn Signal the end of the turn
ALT+F4 Exit Exit CONQUER FOR WINDOWS

While Pointing To Pieces

Key Mouse Action Description
None LEFT-HOLD+DRAG Move piece
None LEFT-CLICK Select piece into the cache
SHIFT LEFT-CLICK Get information on the piece
SHIFT LEFT-CLICK In Information dialog, set piece to sentry
CTRL LEFT-CLICK Select area

While in Tactical or Production View

Key Mouse Action Description
None RIGHT-HOLD+DRAG Move map within map window
None RIGHT-CLICK Set production in square
CTRL LEFT-HOLD+DRAG Select a group of map squares
SHIFT LEFT-HOLD Display coordinates of squares

While Pieces Are Cached

Key Mouse Action Description



None LEFT-CLICK If within range, move piece to new location
None LEFT-CLICK If outside range, move piece and set path
None LEFT-HOLD+DRAG Over cache, select individual pieces
None RIGHT-CLICK Select one more piece from the cache
CTRL None Select one more piece from the cache
SHIFT None De-select one more piece from the cache
DEL None Disband selected pieces

While Area Is Selected

Key Mouse Action Description
None LEFT-CLICK Set group paths and city paths
CTRL LEFT-CLICK Set parallel path
None RIGHT-CLICK Set production in area non-city squares
SHIFT LEFT-CLICK In production dialog, include city squares



Menu Commands

There are five pull down menus, each pertaining to a specific category: File, Game, Statistics, Options, 
and Help. Many of the menu commands can also be given by a hot key sequence, and some are 
duplicated by a button in the tool bar. Some menu commands may not be available in all situations and 
are "grayed out".

File Menu
Game Menu
Statistics Menu
Options Menu
Help Menu



The Playing Pieces

There are two types of pieces, military and static. The military pieces, Infantry, Tanks, Planes, and Ships 
can move and attack. The static pieces, Food, Mineral Resources, and Cities, determine how a map 
square is used.

Military pieces have a movement factor, an attack factor, and a defense factor. Each of these determine 
how well a piece moves or performs in combat. Building any piece requires food and mineral resources.

The static pieces are used to aid in the production of military units. Captured squares can be converted to
food producing, mineral resource producing, or can be used as a site for a city. The heart of all production
is the city, since only a city can produce military pieces.

Military Pieces
Infantry
Tanks
Planes
Ships

Static Pieces
City
Food
Mineral Resources



Production

There are two basic types of production: city production and non-city production. Only city squares can 
produce pieces, while non-city squares can only produce food, mineral resources, or a city. Point to any 
captured square and click on the right mouse button to pop up the Production Dialog Box used to set the 
production capabilities of that square.

A captured square is any land square that you have moved an infantry or tank through. Ownership is 
denoted by a colored outline around the square in the color of the player who captured it.

City Square Production
Non-City Square Production
Building Cities



The Map

The playing area, or "map", is divided into 71 squares in the horizontal direction by 40 squares in the 
vertical. The map allows a horizontal "wrap-around" but not a vertical. Pieces may travel indefinitely in a 
horizontal manner (circling back to where they came), but may not cross the map boundary in the north or
the south.

There are eight different map symbols used, each denoting a different type of terrain. Depending on the 
terrain, there are restrictions on the type of piece that may move through that square. Since the map is 
only a two dimensional representation of a globe, moving off the top or the bottom of the world is not 
allowed.

Land/Plains
Sea
Forest
Desert/Beach
Mountains
Ice Cap/Tundra
City
Ruins



Movement

All pieces have a movement factor that is used to determine the number of squares a piece can travel in a
turn. Infantry can move one square per turn; tanks can move two squares per turn; ships can move three 
squares per turn; and planes can move four squares per turn. Any piece may move none, some, or all of 
their movement factor in a given turn. Under no circumstances may a piece's movement factor be 
transferred to another piece.

The simplest form of movement is the Drag and Drop method. Basically, you point to a piece in a square, 
click and hold the left mouse button, move the mouse to point to a new destination, and release the left 
mouse button. Assuming that the pieces can legally reach the destination square, then the pieces will 
move to that square. For more control over movement and combat, see the Cache.

Movement is restricted to terrain types that are compatible with each piece. Infantry and tanks can only 
move on Land/Plains, Forest, Desert/Beach, and City squares. Ships can only move on Sea squares, with
the exception of the city square where the ship is built. A ship can be produced in any city square that is 
next to a sea square, but upon moving can never return to that city square. Planes can move (fly) over 
any square with no terrain restrictions.

The exception to all movement is combat. Moving into enemy squares is considered combat, and, no 
matter what the piece, all movement stops for that turn when the piece enters an enemy square.

All movement and combat are simultaneous. That is, while you are moving so is everybody else. In fact, 
you may be positioning your pieces for a great offensive thrust when an opponent takes out most of your 
line with an offensive of his own. Also, due to the "fog of war", sometimes you are never quite sure what 
hit you.

Stacking Limits
The Cache
Sea Transport
Paths



Combat

Combat is inseparably linked with movement. In fact, combat is defined as moving into an enemy square. 
All rules for movement and stacking apply to combat.

Engaging the enemy is complicated by the fact that you can not see enemy pieces until they are next to a 
square that you have captured or next to one of your ships or planes. If your square is taken by the 
enemy or the ship or plane is destroyed, the enemy becomes hidden again. Enemy squares are outlined 
in the enemy's color - the same color that surrounds the player's name at the lower right of the screen.

Movement Into Unoccupied Enemy Squares
Defending
Attacking
Combat Resolution



Victory Conditions

Victory is met when you have annihilated all your enemies or when they have all surrendered to you. The 
faster you do this, with the most land, and a higher battle won/lost ratio, the higher a score you will 
receive.

In some scenarios, you may be given a limited number of turns to achieve an objective. In the end, the 
player with the most points will be considered the winner.



Dialog Boxes

Each dialog box is used to exchange data, either displaying some game statistic or prompting you for 
some "important" data like player name or modem speed.

Battle Statistics Information
Color Modem/Serial Connect
Color Preferences Modem/Serial Setup
Current Scores Planning Statistics
Elite Conquerors Production
Enter Group Name Production Ratios
Enter Player Name Resource Statistics
Exit Game Save Password
Game Save As Search
Game Setup Select Game Type



The Tool Bar

The tool bar contains buttons for the most commonly used commands. All of these commands can also 
be given from the menus or from a hot key. Once you become familiar with the hot keys, you may want to 
disable the tool bar (see Options Menu).

Turn Done
Follow Path
Show Tactical View
Show Production View
Show Global View
Show Communication Area
Food and Resource Usage Bar



The Status Bar

The status bar, located at the bottom of the map screen, displays game data and the cache. Unlike the 
tool bar and the scroll bars, the status bar can not be disabled.

Turn Indicator
Map Position
Player Names
Cache Bar



The Computer Player

The computer player is based on sound strategic principles with a high degree of intelligence. The 
computer player uses complex algorithms and makes use of the computational power available to it. 
However, most human players should be able to soundly whip the computer at the lower skill levels.

In fact, if the human player is familiar with the game, there is no reason why that person couldn't beat the 
computer most times at the mid to upper skill levels as well. However, it should be difficult (but not 
impossible) for a strong player to beat the computer at skill level 10.

Though sometimes it may not appear so, the computer plays by most of the same rules you do. The 
computer must abide by food and mineral resource production restrictions when building pieces. However
in the upper skill levels, the computer is given a head start on some production capabilities. The computer
must abide by terrain and movement factor restrictions and will not cheat by computing combat wrong or 
"magically" placing pieces at strategic locations on the board.

The basic computer strategy is to defend any cities it builds by leaving some pieces in each city and to 
aggressively and systematically grab land for its own use. If the computer player finds enemy pieces, it 
will react by meeting force with equal or greater force.

In general, the lower skill levels in single player games are interesting for learning the game or testing out 
new strategies while the higher skill levels might require hours of effort to (possibly) defeat the computer. 
Adding a higher skill level computer player to a two or three player game could potentially spice up the 
game and possibly complicate your opponents' strategies.



Multi-Player Games

Multi-player games require that at least two computers are connected in some manner that facilitates data
exchange between the two computers. Data communications can be divided into two parts: a hardware 
component and a software component.

The hardware is typically serial cables, modems, or network adapters. The software is usually the system 
interface, known as a "driver". Under Windows, a driver is automatically loaded for serial and modem 
communications, but the network driver, known as the NetBIOS, must be loaded from DOS before starting
Windows. Windows for Workgroups is the exception.

Differences From Single Player Games
Modem Connection
Direct Serial Connection
Network Connection



File Menu

In general, the File Menu is used to load, save, or exit a game. The New Game, Load Saved Game, and 
Exit commands will terminate the currently playing game if one is in progress. The save options can be 
used on any turn, and the Elite Conquerors can be viewed at any time.

New Game
Load Saved Game
Load Scenario
Save Game
Save Game As
Elite Conquerors
Exit



Game Menu

Most of the options available on the Game Menu are commands that are given on a regular basis 
throughout the game. Most of these commands are also represented by buttons on the tool bar.

End Turn
Follow Path
Show Production
World Map
Communication Area
Pause Game
Production Ratios
Disband Troops
Surrender



Statistics Menu

Selecting any options on the Statistics Menu will pop up a dialog box with game statistics. Each of the 
optional hot keys can close the dialog box as well as open it. Also, the hot keys can be used to switch 
between each of the statistical dialog boxes.

Planning
Resources
Battle
Current Scores



Options Menu

The items on the Options Menu are used to customize the playing environment. Options like sound and 
scroll bars can be enabled or disabled, and players' colors can be set to personal preference. When an 
option is considered a "toggle" - an on or off switch - the menu item is checked when the option is 
enabled. These options are saved and will be used the next time you start the game.

Sound
Tool Bar
Scroll Bars
Colors
Save Password
Automatic Saves



Help Menu

Like most Windows applications, the online help for CONQUER FOR WINDOWS uses the standard 
Windows help system. This means that this help file, CONQUER.HLP, can be read by WINHELP.EXE. 
Because the help system uses a familiar interface, it should be easy to traverse the online help.

Contents
Search for Help on
How to Use Help
About CONQUER



New Game Command

This command is used to start a new game. If you select this item, the Select Game Type Dialog Box will 
pop up so that you can select the type of game to start, a Local, Modem, or Network game. A local game 
is you versus computer opponents, while modem and network games involve other human players.

If you choose to start a new local game, you will be prompted for your name in the Enter Player Name 
Dialog Box. Local games are the easiest to start since they do not require any special hardware.

If you choose to start a modem game, you will be prompted for some communications hardware setup 
information and a phone number to dial in the Modem/Serial Setup Dialog Box. From there you proceed 
to the Modem/Serial Connect Dialog Box, and then to the Enter Player Name Dialog Box.

If you choose to start a network game, you will be prompted for the player group in the Enter Group Name
Dialog Box and then prompted for your name in the Enter Player Name Dialog Box. To be included in the 
same game, all players must type in the same player group name.

No matter which type of game you are starting, after entering your name, you can set the number of 
computer players, set the skill level, and choose the game map from the Game Setup Dialog Box.



Load Saved Game Command

This command is used to restart a game that had been saved in a previous session. When chosen, the 
Select Game Type Dialog Box pops up. The procedure for starting the game is identical to the New Game
Command. However, in the Game Setup Dialog Box, instead of choosing maps, you choose from a list of 
saved games.

All saved files are saved in the same directory as CONQUER FOR WINDOWS and are easily noticeable by 
the .CQR extension. If the list of saved games grows too long, you may wish to use the Windows File 
Manager to delete some of the older .CQR files.



Load Scenario Command

Choosing this menu item loads a scenario that shipped with the game. When the Select Game Type 
Dialog Box pops up, the procedure for starting the game is identical to the New Game Command. 
However, in the Game Setup Dialog Box, instead of choosing maps, you choose from a list of scenarios.

The "Tutorial" is a scenario that is described in Part 3 of the manual. Unlike new games, most scenarios 
start a given situation with units already built and end after a set number of turns.



Save Game Command
Save Game As Command

This command is used to save a game that is currently in play. The save happens at the END OF THE 
CURRENT TURN. In other words, the Turn Done Command must be given before the game is saved.

If you are playing a network or modem game, then information from the other players are downloaded to 
you computer and saved in the save file. Since quite a bit of data has to be sent over the remote 
connection, there may be a slight time delay when you save the game. This is especially true for modem 
games played at slower baud rates -- just as if you were downloading a file from a BBS

The game is saved in a file that is given a ".CQR" extension. If you have not previously specified a 
filename for this session or if you chose the "Save Game As" command, then the Game Save As Dialog 
Box will prompt you for the name of the save file.

Once the filename has been entered, then the save file is updated with the new data and the older data is
deleted. The save file contains all the data necessary to continue the game from the end of the current 
turn.

The "Save Game" command can also be given from the keyboard by pressing CTRL+S.



Elite Conquerors Command

This command is used to display the Elite Conquerors Dialog Box which gives the high scores. Scores 
are based on several factors including skill level, number of turns played, number of opponents, and 
battle won / lost ratios.



Exit Command

This command is used to end the game that is in play and quit CONQUER FOR WINDOWS. If the game had
not been previously saved, then you are prompted to save the game before exiting by the Exit Game 
Dialog Box.

This command can also be given from the keyboard by pressing ALT+F4.



End Turn Command

This command, also known as "Turn Done", is used to signal that your turn is finished and you wish to 
proceed to the next turn. In a local game, this happens almost immediately.

If you are playing a network or modem game, you may need to wait for your partners to finish moving 
their pieces. Any player that has finished moving will have their player name highlighted on the status bar 
at the bottom of the map window. You can not continue onto the next turn until all players have indicated 
that they have moved.

You can also choose this command by clicking on the first button from the left in the tool bar or from the 
keyboard by pressing CTRL+Z.



Follow Path Command

This command is used to move all units that have been given a path on a preceding turn. Any piece with a
path will move their full movement factor unless they are restricted by terrain, they are restricted by 
stacking limits, or they reach their destination. The path command need only be given once per turn, and 
is given automatically after a Turn Done Command if the path command had not been given during the 
turn.

You can choose this command by clicking on the second button from the left in the tool bar or from the 
keyboard by pressing CTRL+F.



Show Production Command

This command is used to alternate between the tactical view of the map and the production view. Both of 
these are "windowed" views. That is, you can only see a portion of the entire map and you need to scroll 
the screen to see the rest.

The tactical view, which is the default, is used to see all of your pieces and any visible enemy pieces. The 
production view is used to see exactly what each of your land and city map squares are producing.

Moving and setting production can be set while either view is active. However, it's easier to move pieces 
when you can see them in the tactical view and it's easier to set food and mineral resource production 
when you can see the affected map squares.

You can also choose this command by clicking on the third (tactical view) and the fourth (production view)
buttons from the left in the tool bar or from the keyboard by pressing CTRL+X.



World Map Command

This command is used to alternate between a global view of the entire map and a windowed view. All 
operations take place in the windowed view, which is the default, but sometimes it is necessary to get a 
global perspective and see the entire map at once.

You can also choose this command by clicking on the fifth button from the left in the tool bar or from the 
keyboard by pressing CTRL+W.



Communication Area Command

Choosing this menu item, which is only available during network or modem games, opens a 
communication window. When this window is open, you can type messages and receive messages from 
other players.

When the communication area is open, the "input focus" needs to be set to that area for you to type a 
message. Setting the focus to the communication area is indicated by two things, a blinking caret and a 
blue outline around the inside of the area.

To use the keyboard commands, such as CTRL+Z for Turn Done, the focus must be set to the game 
window. In other words, the communication area must either be closed or not have the blinking caret and 
blue outline. Focus is changed between map window and communication area by clicking on the window 
that you wish the focus set to.

Initially, all messages that you send are broadcast to every player. Click on a player name to individually 
enable or disable communication with that player. The player or players receiving your messages are 
indicated by a small speaker icon next to their names. To set communications back to "broadcast mode", 
click on your own player name.

You can also choose this command can also be given by clicking on the sixth button in the tool bar. This 
button is not displayed for local games. You can also give this command from the keyboard by pressing 
CTRL+C.



Pause Game Command

This command is used to temporarily pause or continue a local game. Pause game is used when you 
need to temporarily stop playing but you don't want to close and restart the game.

When a game is paused, you can not issue any commands or scroll around the map. Basically, the game 
is "frozen" until you select this command a second time to resume playing the game. Pausing is not 
available during network or modem games.

You can also give this command from the keyboard by pressing CTRL+P.



Production Ratios Command

Selecting this command will pop up the Production Ratios Dialog Box used to set the food and mineral 
resource production ratios. This can be used to set which percentage of newly captured squares will 
produce food and which percentage will produce mineral resources. You can adjust the production from 
100% food all the way to 100% mineral resources.



Disband Troops Command

This command is used to release units from military service. When issued, any piece in the cache will be 
disbanded.

This is useful when you have too many troops for the amount of food and resources available which may 
prevent any newer, more strategic builds. This is also useful when you have a slower moving piece 
(usually infantry) that is so far from the front line that it is not worth keeping it active any more.

You can also give this command from the keyboard by pressing DEL when piece(s) are in the cache.



Surrender Command

This command is used when you perceive your situation so hopeless, that there is no chance of winning. 
Once you give this order, the game is over for you but may continue for other players if there is more than
one other player still active.

Once a player surrenders, all of that player's cities become "free cities" that can be taken without a battle 
by the first player who reaches them.



Planning Statistics Command

This command is used to display the Planning Statistics Dialog Box which gives information about the 
number of pieces in use and the number of pieces under construction. The food and mineral resources 
used to build these pieces are also displayed.

You can also give this command from the keyboard by pressing F2.



Resources Statistics Command

Selecting this menu item will display the Resource Statistics Dialog Box which gives information about the
number of food and mineral resources which are needed, are available from the previous turn (surplus), 
and are being produced.

You can also give this command from the keyboard by pressing F3.



Battle Statistics Command

This is used to display the Battle Statistics Dialog Box which gives information about the number of 
enemy pieces conquered in battle and the number of friendly pieces defeated in battle. A good won 
versus lost ratio improves your final score.

You can also give this command from the keyboard by pressing F4.



Current Scores Command

Selecting this command will show the Current Scores Dialog Box. This will give you your relative status to
other players in the current game. The value listed here is what would appear in the high score list if the 
game were to immediately end in victory for you. Scores are calculated at the end of each turn.



Enable/Disable Sound Command

This command is used to turn the sound effects and music on or off. To turn sound back on after it has 
been turned off, select this command a second time.

All sounds are in a .WAV format. Most sound cards, like the Sound Blaster Pro™, support this format.

You can also give this command from the keyboard by pressing CTRL+O.



Show/Hide Tool Bar Command

This command is used to hide or display the tool bar that sits above the map window. To redisplay the tool
bar after it has been hidden, select this command a second time. When the tool bar is not displayed, there
is more room to see the map, thus displaying more map squares in the window.

The tool bar has several buttons on it, each representing commands that are frequently given. The tool 
bar buttons are Turn Done, Follow Path, Show Tactical View, Show Production View, Show Global View, 
and, for network and modem games only, Show Communication Window.

You can also give this command from the keyboard by pressing CTRL+T.



Show/Hide Scroll Bars Command

This command is used to hide or display the horizontal and vertical scroll bars. To redisplay the scroll bars
after they are hidden, select this command a second time.

Usually, the easiest way to scroll the screen is to point to the map with the cursor, click and hold the right 
mouse button, and drag the screen to a new position. When you use the mouse to scroll the screen, the 
pointer cursor is replaced by a hand cursor. Release the mouse button when you have situated the map 
where you want it.



Colors Command

This command is used to change colors used to represent each player. Each of these colors can be 
changed from the Color Preferences Dialog Box that is displayed when this command is selected.

Selecting the player whose color you wish to change will display a dialog box, the Color Dialog Box, that 
is identical to the color dialog box used by the Windows Control Panel.



Save Password Command

This command will pop up the Save Password Dialog Box and is used to save the password to be 
associated with the current game. For security reasons, when you save the game the password will be 
saved with the game and then only the person who knows the password can restart the game as your 
player.

This is useful during network or modem games by preventing other people from saving a game and 
restarting it under your name to view your position. Naturally, you would need to enter the password if you
restart the game at a later date.



Automatic Saves Command

Selecting this menu item will let you set the number of turns between automatic saves. A second drop 
down menu on the side of the original menu gives you the option of disabling automatic saves or setting 
saves to 1, 2, 5, 10, or 20 turns.

Depending on the number of turns you set, the game would be automatically saved after that many turns 
have passed. Just like the Save Game option from the File Menu, the saved file can later be reloaded 
under using the Load Saved Game command.



Help Contents Command

This command is used to display the main menu in this online help file. Much of the manual has been put 
online for easy reference.

This command can also be given from the keyboard by pressing F1.



Search For Help On Command

This is used to skip the main menu in this online help file and go straight to a subject. The Search Dialog 
Box is displayed which allows you to type in a specific subject and go directly to that subject. This is the 
standard search dialog box that most Windows applications use.



How To Use Help Command

This command is used if you are unfamiliar with Windows help files. This will display the standard 
Windows help file that is also available from the Program Manager and the File Manager.



About CONQUER Command

This command is used to display the "About CONQUER Dialog Box" which gives the current version of 
CONQUER FOR WINDOWS along with a who's who of the people involved in developing and releasing this 
game.



Infantry Pieces

Infantry's production rate of two turns and their cost of only two mineral resources make them useful as a 
quick defensive solution. Since their attack factor of one and their ability to move only on square per turn 
limits the offensive role that infantry plays, they are generally used to guard cities, shorelines, or other 
areas from attack. In fact, their defense factor of two, which is the same as tanks, make them an ideal 
choice for "sentries" in each city.



Tank Pieces

Tanks, which take just a little more time than it takes to build an infantry, are superior to infantry in both 
movement and attack. Tanks' attack factors of three and their ability to move two squares per turn will 
probably make tanks the core of your army.

Tanks are ideal for attacking enemy strongholds, capturing land, and garrisoning strategic areas. Though 
their defensive factor of two is the same as infantry, tanks make ideal defensive units as well. As with any 
good defense, the ability to counterattack is sometimes a necessity - an ability that tanks provide very 
effectively.



Plane Pieces

Planes are good at searching and destroying enemy lands, cities, ships, and other pieces. Since planes 
have no terrain restrictions and have a superior movement factor of four squares per turn, they can travel 
the world seeking out the enemy.

Planes are considered "strategic" and therefore take a long time and a fair number of resources to build. 
Their seven turn production build and 14 mineral resource cost may discourage you from building and 
using planes, but with an attack factor of four, they have a definite attack advantage. You may find that in 
the early stages of the game, one or two planes may be built when looking for the enemy, but in the late 
stages of the game, massive amounts of planes may be built to search and destroy retreating pieces.



Ship Pieces

Ships are necessary to carry ground units (infantry and tanks) from one continent to another. Since a 
movement factor of three squares per turn gives ships the ability to move faster than ground units, it may 
even be advantageous to use ships to transport pieces from one part of a continent to another part of the 
same continent. Each ship may carry up to eight ground units plus up to eight planes. When stacked with 
planes, given the ship's attack factor of six, they also become very dangerous to enemy ships.

Ships are considered "strategic" and therefore take a long time and plenty of resources to build. Their 
production rate of nine turns at a cost of 36 resources, means there probably won't be too many ships in 
the game. Unless you find yourself on a small island, you might not have much use for ships until the 
middle of the game; however, since it takes so long, ship building has to be planned well in advance.



City Pieces

Only City squares can produce military pieces, making the production of cities probably the single most 
important factor in winning CONQUER FOR WINDOWS. Cities take a very long time (20 turns) and require 
an enormous amount of resources to produce (160 mineral resources). Because of this, production levels,
especially mineral resources, need to be constantly monitored. Though cities also have a defensive factor
of four that other squares do not, it is usually in your best interest to guard cities from attack.



Food Pieces

Food can be produced on any square that a ground unit can pass through. Any square designated as 
"food producing" will produce food at a rate of one food unit per turn. These squares have no defensive 
capability, aside from any pieces residing in them.



Mineral Resource Pieces

Mineral Resources can be produced on any square that a ground unit can pass through, just like food 
producing squares. In some dialog boxes, mineral resources are referred to as Gold for brevity. The term, 
Mineral Resources, is actually an abstraction for any substance mined or drilled from the earth and could 
represent oil, coal, or gold as well.



City Square Production

Infantry, Tanks, Planes, and Ships can only be produced in a city. Furthermore, ships can only be 
produced in a city that lies next to a sea square. Each piece requires time, food, and mineral resources to 
produce. By selecting the type of piece to produce, you are automatically incurring the cost in food and 
mineral resources to produce that piece.

Every piece costs one food unit per turn to build; however, the cost in mineral resources depends on the 
type of piece being built. An infantry takes two weeks and two resource points; a tank takes four weeks 
and four resource points; a plane takes seven weeks and 14 resource points; and a ship takes nine 
weeks and 36 resource points to build.

The total cost in mineral resources is divided evenly into each turn. For example, a ship takes nine turns 
to build at a cost of 36 resource points. Therefore, four resource points are spent on each of the nine 
turns.

Once the required time has elapsed, assuming that the required resources are available, the piece will 
appear at the beginning of the next turn in the city that built it. If there are not enough resources to build 
all pieces under production, then random cities have their production needs fulfilled until available 
resources are depleted.

For example, ten cities are each building tanks. Each city will requires one resource point per turn per 
unit. However, if only seven squares are producing mineral resources, then seven cities, chosen at 
random, will continue to build tanks, while three cities will have their production halted for one week. 
Since this is random, a different seven cities may have their production needs fulfilled on the following 
turn. It is very important that there are enough food and mineral resources for pieces to be built on time.



Non-City Square Production

Building any piece requires Food and Mineral Resources. Typically this is achieved by designating non-
city map squares to produce either food or mineral resources. At the beginning of each turn all food 
squares are counted to give a food total and all mineral resource squares are counted to give a mineral 
resource total. These, added to the surplus from the previous turn, give the total available food and 
resources that are then used in determining piece builds.

Every piece and every city requires one food unit. You'll notice as the game proceeds that your food 
needs will increase as the number of pieces increase. If you don't produce enough food, city production 
will be limited as cities are given available food in random distribution. This is similar to the mineral 
resource distribution described under City Square Production.

Mineral resource production represents, in an abstract fashion, the production of gold, oil, coal, and other 
resources necessary to keep an industrial nation's war machine humming. Without the proper supplies of 
mineral resources, pieces can not be built on time and your cities become vulnerable to attack.

Besides the conventional method of setting production in each square - pointing to the square and 
clicking on the right mouse button - there is a way of setting a whole area to either food or mineral 
resource production. To do this, point to the upper left corner of an area whose production you wish to 
change. Then, while holding down the CTRL key, click and hold the left mouse button. Drag the mouse 
toward the lower right corner of the area whose production you wish to change.

At this point, an animated rectangle will surround the squares that have been selected. By pointing to any 
square within that rectangle and, using the right mouse button, clicking on that square, a dialog box with 
just food and mineral resources will be displayed. Click on either one and all squares within that rectangle
will change to producing either food or mineral resources.

Squares that have cities in them or are producing cities will not be affected. Be careful when clicking the 
right mouse button, though. If you accidentally click the left mouse button you may inadvertently set a 
group path (see "City Paths or Group Paths").

Another option is available to including setting production of city squares to food or mineral resources. Be 
very careful about using this because cites being built are also affected.

Follow the previously described procedure of selecting an area of squares. Same as before, click on the 
right mouse button to bring up the production dialog box. To set production that includes cities, hold the 
SHIFT key down while clicking on the production selection in the Production Dialog Box. Again, be very 
careful since any squares with cities under construction will also be transformed to the item you chose 
from the dialog box.



Building Cities

Building cities, which naturally can occur only in non-city squares, is probably the single most important 
element in CONQUER FOR WINDOWS. Without enough cities, too few pieces are produced, and you would 
quickly fall in defeat. However, since cities are so expensive and take so long to build, it is imperative that 
you have the necessary mineral resources to build them. It is easy to become trapped into building too 
many cities and then find yourself with no mineral resources to finish building them!

Finding the proper place to put cities is important as well. Since cities have a defensive factor to them, 
they can be used like fortresses if you line them between two mountain ranges or line them along a coast 
line. Beware, though, since cities can be captured, don't build them in areas that are too vulnerable.

If you have captured an enemy city, the city is considered "in ruins" and needs to be rebuilt. Rebuilding a 
captured enemy city is expensive, but not as expensive and time consuming as building a city from 
scratch.



Land/Plains Map Square

This is the "normal" brown Land square that comprises the majority of most maps. All pieces but ships 
may pass freely through this square. Once a ground unit passes through this square, it becomes 
"captured". When captured, a City may be built, or food and mineral resources may be produced.



Sea Map Square

Only ships and planes may pass through blue Sea squares. For ground units to travel across water, they 
must be carried by a ship. Planes may either fly across ocean squares or be transported by ships. Unlike 
Land squares, sea squares may not be captured; in other words, after a ship has moved out of a square, 
it becomes a free square again.



Forest Map Square

The green Forest square has exactly the same properties as the Land/Plains square. That is, all pieces 
but ships may pass freely through this square at their full movement rate. Also, like the Land/Plains 
square, a Forest square becomes captured when a ground unit passes through it. If captured, a City may 
be built, or food and mineral resources may be produced.



Desert/Beach Map Square

The yellow Desert/Beach square has exactly the same properties as the Land/Plains square. That is, all 
pieces but ships may pass freely through this square at their full movement rate. Also, like the Land/Plains
square, a Desert/Beach square becomes captured when a ground unit passes through it. If captured, a 
City may be built, or food and mineral resources may be produced.



Mountains Map Square

Gray Mountains are impassable to all ground and sea units. Only planes may fly over Mountains. 
Mountains make a good anchor for a defensive line, especially if you string a line of Cities between two of
them. Since only planes can move over Mountains, they make a good place for planes to hide or regroup 
when attacking distant enemy positions.



Ice Cap/Tundra Map Square

Light blue Ice Cap/Tundra squares are impassable to all ground and sea units. Only planes may fly over 
the Ice Cap/Tundra. These squares are usually used to "mark" the map's northern and southern borders. 
Because this is only a two dimensional representation of a globe, moving off the top or the bottom of the 
world is not allowed.



City Map Square

Black and red City squares are unique because they are the only "man-made" squares on the playing 
surface. Cities, which also have defensive capabilities, can be built on any captured square. For 
information on how to build Cities, see "Building Cities" and for information on pieces built in Cities, see 
"City Square Production".



Ruins Map Square

Black and red Ruins are the result of Cities being captured by an opposing force. Ruins have no 
defensive capability or production beyond the standard non-city production capabilities of food, mineral 
resources, or Cities. The advantage of Ruins is that, in a very short period, they can be turned back into 
full-fledged, productive Cities.



Stacking Limits

Several pieces on one square is called a "stack". During movement, stacking limits need to be kept in 
mind. A combination of up to eight ground units (infantry and tanks), up to eight planes, and one ship may 
be placed on any square. A ship may carry up to eight ground units plus up to eight planes. If you attempt 
to stack more than is legal, then only a legal number will be allowed to move onto the stack, leaving the 
remaining pieces behind.

For example, assume a player has three infantry, four tanks, and six planes in one map square. He then 
attempts to move two tanks, and five planes onto that stack.    Since that would violate stacking limits, only
one tank and two planes actually move on to that stack, leaving behind one tank and three planes.



The Cache

The basis for all movement and combat in CONQUER FOR WINDOWS is the Cache. The cache is a 
temporary holding area for pieces before they are "given orders" to move from one square to another. 
While a piece is in the cache, it is still "physically" on the square and may suffer attacks from an enemy 
even while in the cache.

The cache is displayed as a bar at the bottom of the screen that shows a row of icons representing each 
piece. The cache temporarily replaces the player names when the cache is active.

Only pieces from one square at a time may be selected into the cache. Pieces may be selected out of the 
cache to move to a different square or stay in the same square. Only previously unmoved pieces in a 
given turn may be selected into the cache.

The quickest method of selecting pieces into the cache is to use the mouse to click on a square with 
unmoved pieces. All unmoved pieces are placed in the cache from that square. In the cache bar, 
individual units may be selected for movement by clicking and dragging the mouse over the pieces to be 
moved. The default is for all pieces in the cache to be selected for movement.

A second, more controlled, method of selecting pieces is to use the mouse to point to a square with 
unmoved pieces and hold down SHIFT while clicking on that square. The Information Dialog Box will pop 
up, giving you the option to individually select unmoved pieces into the cache. This is an excellent way to 
distinguish pieces that have already used some of their movement factor from pieces that still have their 
full movement factor left.

Once pieces in the cache have been selected for movement, point to the square you wish to place the 
pieces and click on that square. As long as that square is within movement range and all stacking rules 
are obeyed, the pieces will move to that square. If the destination square is further than one turn's 
movement factor will allow, the pieces will move as far along the path as possible before ending their 
movement.



Sea Transport

Movement over ocean squares is necessary to invade other continents or even to sneak up behind an 
enemy on the same continent. Ground units embark on ships by moving to a coastal sea square - a sea 
square next to a land square - that contains a ship. There is no movement factor penalty to load or unload
a ship other than the number of squares that a ground unit must travel to get to the ship.

To unload a ship, first move the ship to a coastal sea square. You can move the pieces off by selecting 
them into the cache and moving them as you would a normal cache move. The "quick" method of 
selecting pieces on a ship into the cache is to double-click on the ship.

While moving a ship, the transported ground unit also expends its movement factor. For example, a ship 
carrying two infantry and two tanks begins its turn from land. When the ship moves that one square, all 
pieces expend one movement point. This causes the infantry to have no moves left while the tanks are 
left with one. The tank may move one square onto the land but, the infantry must remain on board for at 
least one more turn.

Ships are never limited by the movement factors of the pieces they carry. A ship can always move three 
squares regardless of the pieces it carries. In fact, sea transport is the only method in which a ground unit
can move more than its movement factor.

Ships may also carry planes, but since planes move faster than the ships, this is rarely necessary. In a 
more likely situation, planes are stacked with ships to protect them during attack.



Paths

Since moving large numbers of pieces can be both tedious and time consuming, a piece can be given a 
linear Path to follow. In general, paths can be used to give distant, scattered pieces a staging area near 
the front lines. Or they can be used to send pieces off to grab and explore land. Whatever your purpose 
for using paths may be, they provide a way to move pieces long distances over several turns without 
having to manually move them each turn.

To set a path, move a piece to a square further than it can move in one turn. The piece will move as far as
it can, and rely on the path command to move on subsequent turns.

When a piece has a path, it moves its maximum movement factor along a straight line toward the 
destination square. A piece will stop only if it reaches its destination or if it cannot traverse the next square
in the path due to terrain restrictions or stacking limits. If there are enemy pieces along the way, instead of
moving, a piece may find itself in combat.

The path command can be given manually or automatically. This command is given manually by clicking 
on the "Path" button any time during a given turn. If a path command has not been given during a turn, it 
is automatically given at the end of the turn when the "Turn Done" button is clicked.

City Paths
Group Paths
Parallel Paths



Movement Into Unoccupied Enemy Squares

Movement into an enemy square is considered a combat move. That is, regardless of a piece's 
movement factor, all movement stops for that piece until the next turn. In other words, any piece - planes 
included - can move one square per turn in enemy territory.



Defending

All pieces in a square, regardless of whether they have moved or not, defend that square by totaling their 
defense factors. The only exception to this is ships at sea - only planes and ships count towards combat 
in sea squares not adjacent to land squares. When a ship at sea is lost, all ground units being carried are 
also lost.

In defensive combat, ships on the shoreline are treated like ground units, and can be boarded and 
captured by enemy ground units. In this case, any ground unit on the ship takes place in the ship's 
defense.

Newly built ships that are still in the city that built it have a defensive factor of zero. In other words, it is 
usually best to move ships into the water as soon as possible.



Attacking

Attacking takes place by moving into an enemy occupied square. All selected pieces in the cache total 
their attack factors together and that total is used against the total defense factors. Immediately upon 
engaging the enemy, the computer figures out the resolution of the battle (see "Combat Resolution").

Since combat is movement, all pieces must start in the same square to be involved in a given attack. In 
other words, pieces in two squares may not combine together to attack one enemy square. They may, 
however, attack in sequence - one stack attacks followed by an attack from the second stack. This is 
usually not as effective as combining to one stack and attacking in concert.

When attacking enemy pieces on sea squares, only planes' and ships' attack factors count. Just like 
defensive combat, all ground units are lost when a ship is lost. Again, like defensive combat, ground units 
are only involved when the battle takes place on a coastline.



Combat Resolution

Combat is decided immediately upon attacking. Combat is continued until one stack is destroyed. The 
winner is determined by the percentage chance of winning based on the attack and defense factors 
involved. For example, ten attack factors versus ten defense factors have a 50% chance of winning since 
the combat factors are identical. However ten attack factors versus five defense factors have a 66% 
chance of winning.

If you end up capturing a city after combat in a city square, the city is considered "in ruins" and may be 
rebuilt at a cost of 40 resources over five turns. Ruins have no defense factor and consume mineral 
resources at the same rate as building a new city. However, it is much quicker to rebuild a captured city 
than to build a new one from scratch.



Battle Statistics Dialog Box

This is one of the informational dialog boxes that are available during the course of a game. You can 
reach this dialog box by selecting Battle... from the Statistics Menu or by pressing the hot key, F4. The 
informational dialog boxes can be popped up, switched to, or closed by pressing the relevant hot keys.

The battle statistics are presented in a table format, where the columns list the conquests and defeats 
and the rows list each type of piece. The data presented here is relevant to the scoring - the better the 
conquests to defeats ratio, the better your score.



Color Dialog Box

This dialog box, displayed when a player is selected in the Color Preferences Dialog Box, is used to pick 
a specific color for that player. This is very similar in operation to the color dialog box in the Windows 
Control Panel. Select a pre-defined color, or make one up, and click "OK". Only solid colors will be used - 
selecting a dithered color will result in taking the nearest solid color.



Color Preferences Dialog Box

Used to set the player's color, you can reach this dialog box by selecting Color... from the Options Menu. 
There are four colored buttons, labeled with the player's name, representing each possible player in the 
game. To change a player's color, click on the appropriate button. From there, the Color Dialog Box will be
displayed, giving you the opportunity to set any color from the available palette. Changes to the players' 
colors are saved and used in future games.



Current Scores Dialog Box

This is one of the informational dialog boxes that are available during the course of a game. You can 
reach this dialog box by selecting Current Scores... from the Statistics Menu or by pressing the hot key, 
F5. The informational dialog boxes can be popped up, switched to, or closed by pressing the relevant hot 
keys.

The scores are listed in numerical order with the highest score on top. Scoring is based on several 
factors, including conquests to defeats ratio, skill level, number of players, and number of turns played. 
The scores are computed after each turn.



Elite Conquerors Dialog Box

This is the high score list. It can be displayed by, selecting Elite Conquerors... from the File Menu. The 
scores are listed in numerical order with the highest score on top. Clicking the "Reset" button lets you 
clear the scores. This will fill the list with player "Anonymous" having a score of zero.



Enter Group Name Dialog Box

When you choose to start a network game from the Select Game Type Dialog Box, you must first enter a 
play group. All combatants must be in the same group. During network play, this is how CONQUER FOR 
WINDOWS sorts out which messages go to which players - especially if more than one game is active at a 
time. The group name must be 15 characters or less and only four players may exist in a given group.

For example, suppose you and a few other people wish to play a network game. At the same time, four 
other people are currently playing. If their "Game Group" is named "WARRIORS", for instance, you and 
your two partners would have to choose something else, like "CONQUERORS".



Enter Player Name Dialog Box

There are two versions of this dialog box, one for local games and the other for network or modem 
games. Displayed just before you reach the Game Setup Dialog Box during game setup, both serve the 
same function by prompting you for your name or "alias". You can enter any name, 15 characters or less.

In network and modem games, a status window will show the players names of any player that is already 
connected. Network games also include the "play group" in the status. The name you enter will show up 
in the status bar at the bottom of the map window and will be used to identify messages sent to other 
players over the network or modem.



Exit Game Dialog Box

If you attempt to exit a game that is in progress, either by selecting Exit from the File Menu, by pressing 
ALT+F4, or by double clicking on the upper left control menu button, you will be asked whether you really 
want to abandon a game in progress. You will be given the opportunity to close the game, "OK"; resume 
the game, "Cancel"; or to save the game before exiting, "Save". If you choose "Save", then a Turn Done 
Command will automatically be given saving the game.



Game Save As Dialog Box

When choosing Save Game for the first time or Save Game As... from the File Menu you are prompted for
the filename of the save file. You may type in up to 15 characters, which should be used to uniquely 
identify the game. Later, you can restore the game by choosing Load Saved Game... from the File Menu.

A DOS filename will be built from the name you give by stripping spaces and special characters, 
truncating to eight characters, and adding the .CQR extension. If your directory becomes filled with too 
many saved games, you may want to use the Windows File Manager to delete some of the older .CQR 
files.



Game Setup Dialog Box

This dialog box, used to start a game, establishes some of the options specific to an individual game. 
These are options, that once set, can't be changed during the course of a game.

Under the heading, "Players/Saved Players", the list of players are shown. When playing over a network 
or a modem, the player names will appear as each player "logs in". Your name will be the first on the list.

If you are restoring a saved game, then a list of names used in the original game is shown to the right of 
the current players' names. If your alias from the original game is not aligned with your current player 
name, then click on the name in the second column that matches yours. That name will be brought to the 
top of the list, aligning with yours.

In the "Scenario/Map" section, a list box is used to display maps, scenarios, and saved games. You can 
select an item from this list by clicking on the down arrow button, scrolling through the list, and clicking on 
the game that you want to play. The default, "New Game - Generated", provides a nearly infinite variety of
maps.

Under the "Computers" heading, you can choose the number of computer opponents. You may have any 
combination of human and computer players as long as the total number of players never exceeds four.

The "Skill Level" is used to "handicap" the computer player and match an appropriate skill against the 
human player. The higher the skill level, the tougher the game, and the higher the potential score. At the 
higher skill levels, the computer player will outproduce you and take a more aggressive approach.

Skill level one is a special case used mainly to learn the game or experiment with strategies. At this level, 
you can see the entire map and see each player's pieces. Normally, these are hidden from view, and you 
must find them.

At any skill level, you can choose to start with the entire map visible or not. This option is provided by the 
radio button, "Unexplored World". When selected, the entire map is black except for areas that you have 
moved pieces through.

The button, "Start", is used to begin playing the game; "Cancel", will close the dialog box without starting 
the game; "Help" will pop up this online help description of the dialog box, and "Password", will display the
Save Password Dialog Box. The password is used to prevent other players from starting a saved game 
and looking at your pieces.



Information Dialog Box

This multi-purpose dialog box provides specific control of individual pieces. It is displayed by holding SHIFT
down and clicking on the left mouse button while pointing to a piece.

Clicking the radio button on the left side of the dialog box next to the piece's icon will select a piece into 
the cache. In a stack, any piece not selected is left, unmoved, on its original square. This is a way to 
selectively cache pieces.

In the center column, the number of moves left are shown. If a piece has no movement left, it is grayed 
out and can't be cached.

On the right side, there are three options under the column heading "Orders". For a piece with no orders, 
a dash, "-", is shown. Pieces which are following a path will list the destination coordinates. For example, 
an entry of "(32,28)" indicates that the piece is moving to column 32, row 28 on the map.

The third option under orders is Sentry. A piece with this order will remain in the square regardless of any 
path command given to it, either specifically or via a group path command. A piece is given a sentry order 
by holding SHIFT down and clicking on the left mouse button while pointing to the radio button next to the 
piece's icon. Repeat the process to remove a piece from sentry duty.



Modem/Serial Connect Dialog Box

After setting up the communication hardware in the Modem/Serial Setup Dialog Box, you are presented 
with several options. The option you choose depends on whether you are dialing or receiving or if you are
just playing over a serial cable. Commands sent to or from the modem will be displayed in the big white 
box.

The "Direct" button is used to establish a connection over a null-modem serial cable. No modem strings 
are sent, and no phone number is dialed. When the other computer is ready to proceed, a "CONNECT" 
string is sent which automatically closes this dialog box on that computer.

Use the "Dial" button to send the initial modem string and the phone number to the modem. When the 
phone rings at the other end, the other player will have to click on the "Answer" button.

The "Hang Up" button will send a hang up string to the modem causing it to disconnect the line if a 
connection is active. This is good for disconnecting failed dials, such as a wrong number.

If you are receiving the call, click the "Answer" button when you hear the phone ring. This will send the 
answer string, usually "ATA", to the modem and establish a connection. Note that the string, "ATA", is not 
the auto-answer command.

To check that your communications parameters are set correctly, click the "Setup" button to pop up the 
Modem/Serial Setup Dialog Box. This is the same dialog box that proceeded the "Modem/Serial Connect 
Dialog Box".

Clicking on "Cancel" will send a hang up command to the modem, close the dialog box without 
proceeding and allow you to start over by choosing other commands from the main menu.



Modem/Serial Setup Dialog Box

When you choose Modem from the Select Game Type Dialog Box, you must first setup the 
communications hardware before starting the game. Setting up the modem or serial port is just like you 
would for dialing a BBS.

If you are doing the dialing, then you will need to enter the phone number. Remember to include any 
necessary prefix if you are dialing out of your area code (for example "1-800") or if you would like to 
cancel call waiting (for example "*70"). If you are receiving the call or are just playing a game over a serial
cable, then the phone number is ignored.

Under the heading, "COM Options", you choose the appropriate COM port and baud rate. The COM port 
is the address of your modem hardware or serial port and is specific to your computer. 

The baud rate is the speed at which your computer and the remote computer send data. Both computers 
MUST be communicating at the same baud rate! For example, if you have a modem that is capable of 
9600 baud, but your partner has one that is only capable of 2400 baud, then you must use 2400 as your 
baud rate setting.

The "Mode Strings" section are specific commands to communicate with your modem. Hayes compatible 
modems respond to the same modem strings, "ATDT" for tone dialing a phone number, and "ATA" to 
answer a phone that is ringing.

You can change these strings, if necessary. In fact, older phone lines may need the "ATDP" command for 
pulse dialing. Also note that the "ATA" command is NOT the "auto-answer" command, it's used to 
manually answer the phone.

Once the appropriate data is entered, clicking on "OK" will take you to the Modem/Serial Connect Dialog 
Box.



Planning Statistics Dialog Box

This is one of the informational dialog boxes that are available during the course of a game. You can 
reach this dialog box by selecting Planning... from the Statistics Menu or by pressing the hot key, F2. The 
informational dialog boxes can be popped up, switched to, or closed by pressing the relevant hot keys.

The planning statistics are presented in a table format, where the columns list the number of pieces and 
resources used and the rows list each type of piece. From here you can see what pieces you currently 
have available, what pieces you are building, and how much you are spending to maintain and build those
pieces.



Production Dialog Box

You can set the production of individual squares by clicking on one of your captured squares with the right
mouse button. You can also set production for an entire area by selecting the area first. In either case, the
"Production Dialog Box" displays the options available to you.

The dialog box will only display the pieces that can legally be produced in the square or region that you 
selected. For example, only city squares next to sea squares can produce ships. Therefore, ships will be 
shown in the "Production Dialog Box" for cities next to water squares.

Clicking on the circular radio button next to the piece in the dialog box will set production to that piece. 
Selecting an area will set production to the chosen piece in all squares but city squares. If you wish to 
include city squares, then hold SHIFT down while clicking on the radio button. Be very careful about using 
this method since you also change production of squares that are building cities, too.



Production Ratios Dialog Box

When playing the game, you need to pay close attention to your production. As you expand your area, 
capturing more land, sometimes changing individual squares or groups of squares becomes time 
consuming.

To ease this problem, use the scroll bar labeled "New Land Production Orders" to set the production of 
any new land that you capture to an appropriate ratio of food or mineral resources. If set to 50% food and 
50% mineral resources, the default, then 50% of the new squares you capture will be food and 50% will 
be mineral resources.

If you need to change large amounts of existing land, use the scroll bar labeled "Owned Land Production 
Orders". Here, you can adjust the exact number of squares producing food or mineral resources.



Resource Statistics Dialog Box

This is one of the informational dialog boxes that are available during the course of a game. You can 
reach this dialog box by selecting Resources... from the Statistics Menu or by pressing the hot key, F3. 
The informational dialog boxes can be popped up, switched to, or closed by pressing the relevant hot 
keys.

The resource statistics are presented in a table format, where the columns list the food and gold (mineral 
resources) and the rows list the totals. The "Available" or surplus added to the "Producing" row gives you 
the total resources available to you for the current turn. The "Total" minus the "Required" produces the 
"Net" - this number must be greater than zero or your production will suffer.



Save Password Dialog Box

You can reach this dialog box by either pressing the "Password" button in the Game Setup Dialog Box or 
by choosing Save Password... in the Options Menu. Entering a password, 15 characters or less, will help 
to protect you against unscrupulous players in a multi-player game. By protecting your game, a player 
can't look at your pieces even if he has access to your computer. Remember to remember your password
- if you forget, you won't be able to play either!



Search Dialog Box

If you are familiar with the Windows Help System, then you have seen this dialog box before. It is used to 
bypass the menu structure in the online help and go direct to a specific topic.

To go to a topic, first scroll down the list of subjects in alphabetical order and select an item out of the list. 
Then, click on "Show Topics", and a list of topics related to the subject are shown in the lower half of the 
dialog box. Select the appropriate topic and click on "Go To" to view help in that topic.



Select Game Type Dialog Box

When selecting New Game..., Load Saved Game..., or Load Scenario... from the File Menu, you are 
prompted for the type of game to play. Click on the appropriate radio button for the type of game, Local, 
Modem, or Network, that you wish to play.

A "Local" game is played against computer opponents on a single machine. Because there is no extra 
hardware to setup, this requires the least setup. From here you are prompted for your name in the Enter 
Player Name Dialog Box.

Select Modem to play over the phone line against one other human opponent. This is also the selection to
choose for starting a game between two computers that are wired with a null-modem cable between their 
serial ports. Setting up a modem game, handled by the Modem/Serial Setup Dialog Box, is similar to 
dialing up a BBS.

Choose Network to play a game on a network that has NetBIOS capabilities. If the NetBIOS is installed, 
then you are prompted for the "play" group in the Enter Group Name Dialog Box.

Loading NetBIOS varies by implementation and you may have to consult your network documentation for 
the specifics. For example, most Windows for Workgroups installations will have NetBIOS automatically 
loaded. Under other networks, however, you may have to either manually load it or add a command to 
your AUTOEXEC.BAT or CONFIG.SYS.

After entering the appropriate data, you will come to the Game Setup Dialog Box. From here, you select 
game specific data and then start the game.



Turn Done Button

Use this button to signal to other players that you have finished moving your pieces and that you wish to 
proceed onto the next turn. If you are playing a game against only computer opponents, you can proceed 
immediately to the next turn. If you are playing a network or modem game, you may need to wait until 
your partner(s) are finished with their turn. Any player that has finished moving will have their player name
highlighted on the status bar.

You can also choose this command from the Game Menu by selecting End Turn or from the keyboard by 
pressing CTRL+Z.



Follow Path Button

Use this button to manually give the path command. Any piece with a path will move their full movement 
factor unless they are restricted by terrain, they are restricted by stacking limits, or they reach their 
destination. The path command need only be given once per turn and is given automatically after the Turn
Done Command is given.

You can also choose this command from the Game Menu by selecting Follow Path or from the keyboard 
by pressing CTRL+F.



Show Tactical View Button

Use this button to select the Tactical View of the map area. The tactical view, which is the default, is used 
to see your pieces and any visible enemy pieces. The opposite of the tactical view is the Production View 
which can be seen by clicking on the "Show Production View" button.

Moving and setting production can be set while either view is active, but it is easier to move pieces when 
you can see them in the tactical view and it is easier to set food and mineral resource production when 
you can see the affected squares.

You can also choose this command from the Game Menu by selecting Show Production or from the 
keyboard by pressing CTRL+X.



Show Production View Button

Use this button to select the Production View of the map area. The production view is used to see exactly 
what each land and city square is producing. The opposite of the production view is the Tactical View 
which can be seen by clicking on the "Show Tactical View" button.

Moving and setting production can be set while either view is active, but it is easier to move pieces when 
you can see them in the tactical view and it is easier to set food and mineral resource production when 
you can see the affected squares.

You can also choose this command from the Game Menu by selecting Show Production or from the 
keyboard by pressing CTRL+X.



Show Global View Button

Use this button to alternate between a global view of the entire map area and the windowed view. All 
operations take place in the windowed view, which is the default, but sometimes it is necessary to get a 
global perspective and see the entire map at once.

You can also choose this command from the Game Menu by selecting Global View or from the keyboard 
by pressing CTRL+W.



Show Communication Area Button

Use this button, which is only available during remote games, to open a communication window to a 
remote player. When this window is open, you can type messages and receive messages from other 
players. By clicking on an individual player's name on the status bar below the map window, you can 
select individual players to send messages to.

When the communication area is open, the "input focus" needs to be set to that area for you to type a 
message. The focus is indicated by a "blinking" caret and a blue outline around the communication area.

To use the keyboard commands in the game, the focus needs to be in the map window. To set the focus 
back to the map window, either close the communication area or click on any location in the map window.

If a message is sent to you, and you do not have the communication area open, two things will signal that 
you have a waiting message. First, if you have sound turned on, the arrival of a message is signaled by 
the sound of a phone ringing. If you don't have sound capabilities, a persistent "beep" of the PC speaker 
signals the arrival of a message.

Secondly, if the tool bar is displayed, the communication area icon changes from the icon of someone 
talking to the icon of someone listening. If either of these occur, open up the communication area by 
clicking on the icon so that the message sent to you can be read.

You can also choose this command from the Game Menu by selecting Communication Area or from the 
keyboard by pressing CTRL+C.



Food and Resource Usage Bar

On the right side of the tool bar, the current usage of food and mineral resources are displayed in a "bar 
chart" format. This chart is useful for getting a quick, up to the moment, report on your usage of 
resources.

The colored bars represent the total amount of resources available to you for the next ten turns. It is a 
relative number, that can be used to get a "feel" for you long term viability.

The number displayed within each bar is the surplus of that resource for the current turn. Obviously, a 
positive number is much better than a negative number.

If you need a more detailed break down on your usage of resources, then refer to the statistical 
information that is available from the Statistics Menu.



Turn Indicator

The first text displayed along the bottom of the map window in the status bar is the Turn Indicator. After 
each turn, measured in "weeks", the turn indicator is updated to reflect the passage of another week. After
52 weeks have elapsed, the number of "years" as well as weeks are displayed.



Map Position

The second text item along the bottom of the map window in the status bar is the Map Position. The world
map measures 71 horizontal by 40 vertical squares. Each square is numbered from 0 to 70 in the 
horizontal direction (left to right) and 0 to 39 in the vertical direction (top to bottom).

Normally, the coordinates of the tactical view window is shown, giving the upper left coordinate followed 
by the lower right coordinate. However, by holding down SHIFT and clicking on any square, that square's 
coordinate is displayed in the map position. Knowing map positions may be useful when sending 
information to allies about enemy locations.



Player Names

Along the bottom of the map window in the status bar, right justified, are the player's names, outlined in 
the player's color. When playing a multi-player game, these become Turn Done indicators. If a player's 
name is filled with the player's color, that player has signaled his turn to be over.

For example, assume you are playing somebody with the name "Quadros". During a turn in which you 
haven't finished moving, the player name box with Quadros' name is suddenly filled in with his color. That 
means that Quadros has clicked on the "Turn Done" button and is now waiting for you to finish your move.
As a courtesy you should finish the turn as soon as possible.

During multi-player games when the communication area is active, a speaker icon is displayed next to 
each name box. By clicking on individual name boxes, you can turn on or off message transmissions to 
that individual. By clicking on your own name, you can turn on all the speakers. When the speaker is "on",
any message you type in the communication area will go to that person.



Cache Bar

As described in the Movement section of the manual, the cache is very important to the game. The cache 
is a bar that temporarily covers the Player Names displayed at the lower right of the map window.

When pieces are placed in the cache, they are shown lined up by piece type. Each piece can be selected 
individually by clicking on it. A group of pieces in the cache can be selected by clicking and dragging 
across them.

For example, suppose two infantry, one tank and one plane are in the cache. To select just the tank and 
plane, click on the tank and drag the mouse over the plane before releasing. The destination that you 
click on will get the tank and plane - the infantry will remain in the cache.



Multi-Player Differences From Single Player Games

When starting a game, the players' names will appear in the Game Setup Dialog Box as they connect. If a
player changes an option such as skill level, then all other players will see the option change in their 
Game Setup Dialog Box. As each player clicks on "Start", the player's name is grayed out. When all 
players have started, the game may begin.

One of the things that you may find different from single player games is the necessity to wait for other 
players to finish their turn. No two players are exactly alike when it comes to the amount of time a turn 
takes. However, for evenly matched players, turns take roughly the same amount of time.

When the status bar indicates that another player has signaled Turn Done, as a courtesy to the other 
player(s), you should attempt to finish the turn as soon as possible. Naturally, don't sacrifice strategy, just 
use reasonable judgment. Note that even after signaling the end of turn, you may still adjust production 
and move any unmoved pieces until all players have indicated "Turn Done".

For multi-player games, a communication area and a button in the tool bar used to show or hide that area 
is provided. You can send messages to all players or to individual players by clicking on the speaker icon 
next to the player's name on the status bar.



Modem Connection

For two computers to communicate over a phone line, data must first be sent to a modem, a device that 
converts the digital computer data into a form that can be sent over phone lines. When a modem on the 
other end receives the data, the data is converted back into a digital form that the computer can use.

Like any computer hardware, there seems to be a large number of acronyms and abbreviations 
associated with the modem. The basic rule of thumb is that whatever communications protocol a remote 
computer uses, so must you. For example, if a remote computer uses V.32 bis then you need to put your 
modem into V.32 bis mode. Fortunately, most modems automatically detect different protocols and try to 
set themselves up properly.

COM Ports
Baud Rates
HST Protocol
Starting a Modem Game



Direct Serial Connection

The most cost-effective method of setting up a two player game is to physically connect a serial cable 
between two computers that are in close proximity. This cable must be a "Null Modem" cable, a common 
item found in most computer or electronics supply stores.

Starting a direct serial game is very similar to starting a modem game. Select the Modem radio button 
from the Select Game Type Dialog Box and click "OK" to get the Modem/Serial Setup Dialog Box.

Adjust the COM Options and the Baud Rate to their appropriate settings. Both the "Phone Number" and 
the "Mode Strings" can be ignored - these are used in modem games.

Click on "OK" to bring up the Modem/Serial Connect Dialog Box. Once the other player is set up and has 
the same dialog displayed, click on "Direct" to establish a direct connection to the other player.

If the communications parameters have been set properly, the other player's dialog box will close and 
each of you will be prompted to enter your name. Only the "Direct", "Setup", and "Cancel" buttons are 
needed during setup for direct serial connection games. The other buttons, "Dial", "Hang Up", and 
"Answer" are used in modem games.

Like the modem game, after each player has selected "Start" in the Game Setup Dialog Box, the game 
begins.

Starting a Direct Serial Game
1. Select Modem from Select Game Type Dialog Box
2. Set Communications Parameters and Click "OK"
3. Either Player Clicks on "Direct" Button
4. Enter Player Name
5. Set Game Options
6. Click "Start" Button in Game Setup Dialog Box



Network Connection

To play a network game, all systems must have a valid version of CONQUER FOR WINDOWS installed 
since the game is based on a "peer-to-peer" model. Establishing a network connection requires that all 
systems use the same network protocol. Unfortunately, this is not something that Windows handles 
transparently and may require changes to your DOS setup prior to running Windows.

NetBIOS
Starting a Network Game



City Paths

Sometimes, after a large number of cities have been built, it becomes time consuming to search for newly
built pieces every turn. By setting a City Path, any new pieces will immediately begin following that path. 
For an individual city, hold the CTRL key down while clicking on the city square and an animated rectangle 
will surround the square. Then click on a destination square, just like you would for a normal path, and the
city path is set.

Once set, any piece built in that city will automatically follow the path to the destination square just as if 
you had set the path manually. To change the path, simply repeat the process of CTRL+CLICK on the city, 
click on the destination. All succeeding new builds will then follow the new path set.

To cancel the path, you make the destination equal to the starting square. Hold CTRL down and click on 
the city square. Then, after the animated rectangle is displayed, release CTRL and click on the same city 
square. Any square that has a path with a destination set to itself has no path.

City paths are especially useful in the middle to end part of the game when a large number of pieces are 
being built and it becomes time consuming to keep track of every city on every turn. By setting a city path 
for a group of cities to a single destination, you end up creating a "staging" area that is much more 
manageable.



Group Paths

Besides the conventional method of setting a path - there is a way of setting a whole area to follow a path 
to a single destination. To set a Group Path, point to the upper left corner of the area whose path you wish
to set. Then, while holding down CTRL, click and hold the left mouse button. Drag the mouse toward the 
lower right corner of the area whose path you wish to set.

At this point an animated rectangle will surround the pieces to be given paths. Point to the square where 
you wish all pieces within the selected area to go, and using the left mouse button, click on that square. 
These pieces will then follow the straightest line from their starting location to the selected destination.

Any cities that happen to be within the group will have their city paths altered to the new destination as 
well. In fact, this is an easy way to set city paths for a whole block of city squares.

This is obviously a very powerful command and should be used carefully. If you recklessly use group 
paths you may find pieces moving off in directions you don't want them to go; or worse, you may find new 
pieces being easily destroyed when they are sent right into enemy fortified positions.



Parallel Paths

If sending pieces straight to a single destination isn't what you desire, but instead you need to send 
pieces on a course parallel to a given path, then use a Parallel Path. A parallel path is nearly identical to a
group path except that pieces don't converge to a single destination - they travel on a path that is parallel 
to an imaginary line drawn from the center of the area outlined by the animated rectangle to the 
"destination" square.

A parallel path is useful in the late stages of the game when you have a large number of pieces along a 
front line that you wish to move forward together. By setting a parallel path, you can advance the front 
automatically.

To set up a parallel path, follow the procedure for setting a group path. The only difference is, instead of 
just clicking to set the destination, hold CTRL down and click the left mouse button. All pieces and new 
pieces built in cities within the selected area are affected.



COM Ports

The modem is attached to the computer through a physical connection, either external or internal. You 
need to match the physical serial connection to the device name, such as "COM1" or "COM2". The device
name is how the software identifies where to send data. If you are unsure about the COM ports available, 
the reference manual that came with your computer system or communications adapter should be able to 
clarify this.

Only one device may be attached to each COM port. It is possible that some of your COM ports may be in
use by another device, such as a serial mouse. Though most printers take a parallel port ("LPT1" or 
"LPT2"), there are a few printers that can connect to the serial port. Knowing the ports other devices use 
may help you narrow down a "free" COM port.

If you are still unsure about which ports are free to use, you may have to use a little "trial and error" to 
figure out which COM port is available. Basically, try each possible device name - there aren't that many - 
until you establish communications.



Baud Rates

To communicate, both computers need to "talk" at the same speed. The speed of data transmission 
between two computers is measured in bits per second, or the "baud rate". For CONQUER FOR WINDOWS,
the minimum data transmission speed is 2400 baud.

For two modems to communicate, they must run at the same speed. In other words, the slower of the two 
modems involved in a modem game determines the baud rate at which you can transmit and receive. For 
example, a 9600 baud modem connected to a 2400 baud modem can only communicate at 2400 baud or 
below.



HST Protocol

Despite your past experience with BBS's, you may find that modems capable of the U.S. Robotics HST™ 
protocol actually run much slower than expected while playing the game. This is due to the way HST 
works.

HST operates under the principal of a "back channel". Basically, a high speed "one way" channel is set up
that uses most of the bandwidth of the phone line. Data sent in the other direction is transmitted at a 
percentage of the high speed rate. While this method works beautifully when data communications is 
mostly in one direction, such as with most BBS's, it introduces a lot of overhead into the two-way 
communications necessary for CONQUER FOR WINDOWS.

During testing, it was found that due to the overhead of the HST protocol, it is actually faster to run the 
game at 2400 baud. You may wish to experiment with finding the optimal communications protocol for 
you, but, we recommend that any protocol that uses a back channel, such as HST, be disabled.



Starting a Modem Game

To start a modem game, select the "Modem" radio button in the Select Game Type Dialog Box. When the 
Modem/Serial Setup Dialog Box is displayed, adjust the "COM Options" and the "Baud Rate" to their 
appropriate settings.

You will need to decide which player will dial and which player will answer. The player who dials needs to 
enter the "Phone Number", complete with any necessary dialing prefix or area code. For example, some 
corporate phone systems require you to dial a "9" to get an outside line.

The player dialing also needs to verify that the "Dialing" string under the "Mode Strings" heading is 
correct. If you have a Hayes™ compatible modem and a tone dial phone line, then the standard "ATDT" 
string should be sufficient. If you have a pulse dial phone line, then you may need to change the string to 
"ATDP".

The player answering the phone needs to verify that the "Answer" string under the "Mode Strings" 
heading is correct. The default, "ATA", is used to answer a phone that is ringing - it is not an "auto-
answer" command.

Once the protocol is set, then click "OK" to bring up the Modem/Serial Connect Dialog Box. The person 
designated the "dialer" clicks on the "Dial" button and, when the phone rings at the other end, the player 
at that end clicks the "Answer" button. The "Hang Up" button can be used at any time during setup to 
cancel the connection. This is especially useful when dialing a wrong number.

Communications ports may not be shared. If you attempt to use a port that is already in use, the system 
informs you of a conflict. This typically happens if a terminal emulator program, such as "Terminal", is 
running in the background. Should you get this error, simply close the application that is using the COM 
port and try again.

Once connected and after each player enters his name, you should see each name listed in the Game 
Setup Dialog Box. You may then choose a map or scenario from either person's machine or change 
options such as skill level and number of computer players. Any changes are reflected on the other 
computer.

A communication area is provided to send messages during setup. Clicking "Start" will signal that you are 
ready to begin by graying out your name on both computers. Once all players have clicked "Start", the 
game begins.

Starting a Modem Game
1. Designate a "Dialer" and an "Answerer"
2. Select Modem from Select Game Type Dialog Box
3. Set Communications Parameters and Click "OK"
4. Dialer Clicks on "Dial" Button
5. When Phone Rings, Answerer Clicks on "Answer" Button
6. Enter Player Name
7. Set Game Options
8. Click "Start" Button in Game Setup Dialog Box



NetBIOS

Successfully loading NetBIOS is the key to playing the game over the network. NetBIOS is a standard 
device-independent interface that most network manufacturers support. It is something that usually is 
[optionally] loaded in the AUTOEXEC.BAT or CONFIG.SYS.

If you are unsure about whether NetBIOS is installed on your system, you may need to consult the 
documentation that came with your network. For some networks, it is an integral component of the 
network, for others it is just an "add-on" that must be loaded separately.

If you are still unsure, try it. CONQUER FOR WINDOWS will detect whether a NetBIOS is present or not. If it 
is found, then you may not need to make any changes.

Even if NetBIOS is loaded, each computer must still be using the same underlying protocol. For example, 
a Windows™ for Workgroups installation running the NetBEUI protocol will not communicate with a 
Windows for Workgroups installation running Novell®'s NetBIOS which uses the IPX protocol. Both must 
be running NetBEUI or both must be running Novell's NetBIOS to communicate.



Starting a Network Game

To start a network game, select the Network radio button in the Select Game Type Dialog Box. You will be
prompted for a group name that MUST be the same for all players in the same game. In other words, 
decide on the group name in advance that all players - up to four people per group - need to type into the 
Enter Group Name Dialog Box.

Like the modem game, after each player enters his name, you should see each name listed in the Game 
Setup Dialog Box. They will appear on the list as each player "logs on". You may then choose a map or 
scenario from either person's machine or change options such as skill level and number of computer 
players. After each player has selected "Start" in the Game Setup Dialog Box, the game begins.

Starting a Network Game
1. Select Network from Select Game Type Dialog Box
2. Enter Game Group
3. Enter Player Name
4. Set Game Options
5. Click "Start" Button in Game Setup Dialog Box


